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Creating a New Tournament Using an Import Team File

NOTE: You must have an Excel (xls) or tab-delimited file of teams for the tournament formatted 
appropriately. Note that you can now create a team file using the software. See Create/Edit Team File.

To create a new tournament, click on the New Tournament Icon (  ) located on the toolbar. The 
Tournament Setup Screen will appear.
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To set up the new tournament, provide the name, location, dates, quiz program, district, type, and 
level information. The dates can be a single date indicated by the same value in both date fields, or a start 
date and an end date. Be sure to select the appropriate district (leave as "Unselected" for tournaments open 
to teams from more than one district, such as open tournaments or North American tournaments).

When creating a tournament from a team import file, you do not need to provide the number of teams. 
This selection is automatic based on the number of teams read in from the import file and the number of 
byes added.

Select the number of byes to add to the matrix. This setting allows you to pad the matrix with up to four byes 
in case unregistered teams show up the day of the tournament. The byes will be placed in the correct positions 
in the matrix so that if they remain byes it is as if a fewer team matrix were used.

Select the Randomly Place Teams in Matrix checkbox to create a tournament matrix with the imported 
teams already randomly placed.

When the Create Tournament from Team File Button  is selected, you will be asked 
to verify the district/region and tournament type.
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After verifying the tournament type, the Import window will appear.

 

Choose the file containing the team and quizzer names (either an Excel xls file or a tab-delimited text file) 
and select the Import Button. If the teams are to be randomly placed, the new matrix will appear with 
the imported teams randomly placed in the matrix. Tournament setup is complete. If the team captains are 
to draw numbers for their placement positions, a message window will appear stating which numbers to hold 
out for byes.

 

Hold out the given numbers for byes and allow team captains to draw from the remaining numbers. Select OK. 
The Team Setup screen will appear. 
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Have each team captain come tell you which number they drew. Select their team number in the first pull-
down menu and select their team name in the second pull-down menu. Select the Update button to update 
the matrix with this team at that number. You will see that team appear in the team table displayed. Note that 
if you do not hit the Update Button the team will NOT be placed at that number. When all teams are entered, 
click the Save Changes Button. Tournament setup is complete.

Note that the drawing of numbers does not have to occur immediately. When the Team Setup screen appears, 
you can select the Cancel Changes Button and get to the matrix. The matrix will be numbered. You can print 
the matrix ahead of time for inclusion in the tournament packet, exit the application, or whatever. When ready 

for the teams to draw numbers, select  from the left-hand side navigation tree.

 

This will bring you back to the Team Setup screen. 

Creating a New Tournament Without an Import Team File

NOTE: If you have an Excel (xls) or tab-delimited file of teams for the tournament, create the tournament 
using these directions. Note that you can now create a team file using the software. See Create/Edit Team File.

To create a new tournament, click on the New Tournament Icon (  ) located on the toolbar. The 
Tournament Setup Screen will appear.
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To set up the new tournament, provide the name, location, dates, quiz program, district, type, and 
level information. The dates can be a single date indicated by the same value in both date fields, or a start 
date and an end date. Be sure to select the appropriate hosting district even if it is an open tournament (leave 
as "Unselected" for non-district tournaments such as Extravaganzas or North American tournaments).

Provide the number of teams. When all of the general tournament information has been entered, select the 
OK button to create a matrix with teams numbered in order.

You will be asked to verify the tournament type.

 

After verifying the tournament type, the numbered matrix will appear.
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When ready for the teams to draw numbers, select  from the left-hand side navigation tree.

 

This will bring you to the Team Setup screen. 

If team captains have drawn numbers for placement in the matrix, enter the teams in the fields at the 
appropriate positions. Type the team name in the field and any quizzer information you know. Another option is 
to select their team number in the first pull-down menu and select their team name in the second pull-down 
menu. Select the Update button to update the matrix with this team at that number. You will see that team 
appear in the team table displayed. Note that if you do not hit the Update Button the team will NOT be placed 
at that number. If a team already exists in your local database, it will autofill. Sometimes a team exists in the 
local database more than once. When this occurs, a team selection window will appear. 

 

The teams are listed by date and selection of the desired team can be made. When all teams are entered, click 
the Save Changes Button. .

Once created, the number of teams in the tournament cannot be changed. If you need to change the number 
of teams you would have to delete the tournament and create a new one. Team and quizzer names, however, 
can be edited after tournament creation.

Create/Edit Team File

You can now create a team file directly within the software. The team information will be saved as a 
Microsoft Excel spreadsheet (xls), which can then be used as a team import file. You can edit the created team 
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file using the software, or using Microsoft Excel, at any time. To create a new team file, select Create New 
Team File from the File Menu.

The Team File Edit Screen will appear.

Initially the team file screen will show five empty rows. Each row represents a different team. To add more 
rows for additional teams, click the Add More Teams button.

You can also edit existing team files by selecting Edit Team File from the File Menu. This selection will allow you 
to find and select the team file to edit. The team file can be an Excel (xls) file, a tab-delimited text (txt) file, 
or even a BQTournament exported tournament (bqf) file. If you select a tournament file, the software will grab 
all team information for the participants of that tournament. This feature is very useful to coordinators, since 
they can easily create a team file from the data from the previous district tournament. When the file is 
selected, the software will read the team data from the file and display it in the Team File Edit Screen.

In each row, provide the team name followed by the quizzer names. Blank rows and cells will be ignored. 
When ready, click the Save button to save your team file. Provide the name and location for the team xls file, 
and be sure to remember where you save it and what you name the file. The file must be saved as a .xls file to 
be recognized as a team file by the software. This newly created team file can then be used as a team import 
file when creating a new tournament. When done, be sure to save your changes then click the Done button.
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Round Robin Tournaments

You can now create a round robin tournament with the software.  This newly added capability has limitations 
right now, though.  It will be improved as time permits.

Currently, the software will create round robins for any number of teams.  However, printing of round robins 
only works for up to 10 teams.

To create a round robin tournament, select the New Tournament icon on the toolbar.  Fill in the 
tournament information.  Right below the dates fields, select Tournament is Round Robin.

Decide whether or not to randomly place teams in the matrix, then click the Create Tournament from Team 
File button.  For now, round robins can only be created using an xls or txt team file.  If there are an odd number 
of teams in the team file, a bye game will automatically be added to make the number of teams even.

Import Teams from Excel Spreadsheet or Tab-Delimited Text File

Team information can be read in from a Microsoft Excel spreadsheet (xls) or from a tab-delimited text file. 
The spreadsheet must be in the following format:

Column A - Team 
Name

Column B - 
Quizzer 1

Column C - Quizzer 
2 Column D - Quizzer 3 Column E - 

Quizzer 4
Column F - 
Quizzer 5

My Team John Doe Jane Doe    

Another Team Mike Brown Amanda Jones Wendy Thornton Janet Wilson  

Similarly, the text file is formatted the same way except the row fields should be separated by pressing the Tab 
key (hence tab-delimited). A tab-delimited text file can be created using virtually any text editor, so if you do 
not have Microsoft Excel you can still create an import file with team information.

The first row is assumed to be column headings and is ignored. Notice that each row contains 
information for one team. For each team, some quizzer columns are left blank if that team has fewer than 
five quizzers. Never leave blank quizzer fields between real quizzers, such as a blank field between the first 
quizzer and the next quizzer. Note that if quizzer names are not known, having just the team name on a row is 
fine and quizzer names can be entered later within the software.

The recommended way to import team information is to create the tournament using an import team 
file. However, it is possible to import team information at any time within the software. To import the team 

data into your application, select the Import button (  ) on the toolbar. The Import window will appear.
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Select the file that you want to import. Click the Import button to import the selected file. The Tournament 
Type window will appear.

If these are Beginner or Junior teams, select Yes. If these are Intermediate or Senior teams, select No. 
Another window will appear allowing for specific selection of the team/tournament type.

After making the team/tournament type selection, the data will import from the file and you will receive a 
message stating that the import was successful. The newly imported team data will now be available in all 
drop-down team choices. The date of import will be used to uniquely identify these teams.

Edit Team Information

There are two ways to edit team information such as team name, number of quizzers, and individual 
quizzer information. The easiest way is to edit teams directly through the matrix. Click on a game in the matrix 
to have the Game Summary Window appear.
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Select the Edit Team button  for the team to edit. The Edit Team Window will appear.

From the Edit Team Window, team name, number of quizzers, and quizzer names can be changed. Also, it 
is possible to use a pre-existing team by selecting a team from the drop-down menu and clicking the Use 
Team button. This action will automatically fill in the appropriate quizzer names for the selected team.

The other way to edit team information, often used when changing information for many teams, is to 

select  from the left-hand side navigation tree.
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Note that to get to the Team Setup selection, you may need to double click the Setup folder (or expand it 
by clicking on the plus sign next to the Setup folder). When selected, the Team Setup screen will appear.

 

Team and quizzer names can be edited directly within the table by highlighting a field and typing. To remove 
a quizzer, just highlight the quizzer name and hit the backspace to empty out the field. When adding or 
removing quizzers, never leave blank fields between one quizzer and another. In other words, do not put your 
first quizzer in the Quizzer 1 column and your other quizzer in the Quizzer 3 column while leaving the Quizzer 
2 column field blank. Blank fields between quizzers are not allowed. Click the Save Changes Button to save 
your changes and return to the matrix.

It is a very good idea to correctly input all team information, including quizzer names, before or at the beginning 
of the tournament, and at least before the team plays its first game. The software can handle edits to 
quizzer information during the course of a tournament, but using default settings for teams (generic 
quizzer names, etc) can be confusing to scorekeepers. To insure that the right statistics are associated with 
the right quizzers, try to have teams set up before the games involving those teams are played. The 
recommended way to initially input team information is to create the tournament using an import team file.

Once a team has been set up, it is stored locally and can be re-used in other tournaments if desired.

Using the Matrix

The tournament matrix can be viewed by clicking on Matrix in the navigation tree. The matrix is interactive in 
that you can click on a game and input results for that game. When game results are entered, the software 
will automatically advance the winning team in round 1 and place the other team in the correct place in round 2.

The matrix can be printed at any time by selecting the Print Button on the toolbar.

The matrix can be saved as a pdf at any time by selecting Save Matrix as PDF from the File Menu.

Entering Quiz Results

When a game is clicked on the interactive matrix, the Game Summary window will appear.
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From this window, you may enter as much or as little information as you wish. You can edit teams using the 
edit teams buttons. You may even edit the scoresheet for this game as it is being played (or afterwards if 
desired). If you choose to edit the scoresheet by clicking the Edit Scoresheet button 

 , this summary window will close 
and the scoresheet panel will appear.

At a minimum, you may select the winning team and click the Save button. Another option is to just enter 
each team's final score followed by the Save button. Individual quizzer statistics and calculation of the 
all tournament team will not be possible with these choices, however.

If you are a tournament official, we strongly suggest that you enter both team and individual scores for each 
quiz. Note that if you edit the scoresheet for a quiz, the summary fields are automatically entered for that quiz. 
By entering data for quizzers as well as teams, the software can calculate all tournament statistics automatically 
for you. This will eliminate calculation errors (careless errors such as crediting a response to the wrong quizzer 
may still occur). 

A forfeit/bye button  is included to quickly handle forfeit and bye games. To use, select which 
team wins, then select the forfeit/bye button. The matrix will automatically be updated and this game will 
be ignored when calculating statistics for the teams. 

Keeping Score During a Quiz

To keep score during a quiz, select Matrix from the left-hand navigation tree to display the tournament matrix. 
If the word Matrix is already highlighted but not displayed, just click on something else in the tree and back 
on Matrix to display the matrix. Click on the game for which you want to keep score. The Game Summary 
window will appear.
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Click on the Edit Scoresheet Button 

(  ) . The interactive scoresheet 
panel will appear.
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Before the quiz begins, make sure that the quizzers at the tables match with the assigned buzzer positions. If 
not, assign quizzers to the correct buzzer positions using the pulldown menus for each position; i.e. click on 

the quizzer menu  to reveal that team's quizzers and select the quizzer to assign to 
that buzzer. The quizzer assignments at the first question will be remembered for future games in which that 
team plays. The scoresheet will reflect seating assignments from the first question.

By default, the Summary Window displaying a summary of team scores, official time, and question 

number automatically appears for each quiz. The Summary Window Button  toggles the Summary Window 
on and off. See View Summary Window and Keep Official Time for more information.

Also if desired, you can switch the default view of team color positions to yellow on left and red on right 

by selecting the Color Switch Button .
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As each question progresses, use the interactive panel to input what happens for that question. Notice that 
for question 1, the red bonus and yellow bonus check boxes are visible. Use these boxes to indicate whether or 
not a team gets their 10 point bonus for being on time to the quiz. The bonus selection boxes are only visible 
when question 1 is active.

 

During the reading of the question, you have the option of inputting the question type(s) 

 (direct, 2-part, 3-part, 4-part, multiple part, cross-reference, 
quotation, quotation completion, and locate) as well as any notes you want to add in the Notes field 

 . Common notes to add would be how many parts to a multiple part 
question, the verse reference, the reason for a foul, etc.. For the question type, more than one choice can 

be selected, such as to indicate a 2-part cross-reference question (  ). It 
is a very good idea to go ahead and get in the habit of indicating the question type, since we will soon be able 
to calculate statistics based on question type in a future version of the software.

If there is no response to the question, click the No Response button (  ). This will indicate on the 
scoresheet that no response occurred and will advance to the next question. The No Response button can also 
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be used for no response on re-reads.

If a quizzer does respond, either click that quizzer's button (  ) or that quizzer's Interruption field ( 

 ). Doing so will automatically start the 30 second scoresheet timer and will highlight the Correct and 

Error fields (  ) as a reminder that you are awaiting the ruling from the quizmaster. Select C 
for Correct or E for Error. The software will automatically fill in the scoresheet appropriately and advance to 
the next question if applicable. Note that for missed interruptions, the question does not advance but awaits the 
re-read for the other team.

You may also indicate individual fouls, team fouls, team attendance bonus points (only on the first question), 
time outs, and contests. For timeouts, the timeout will be indicated on the previous question since the 
software automatically advanced after the question ruling. Note that for contests, the software now 
automatically returns to the previous question since the software smartly advanced after a ruling. If the contest 
is then withdrawn or denied, the software will advance to the next question again. If the contest is granted, it 

will remain on that question awaiting further action. There is a Reset Button  provided to quickly clear 
out fields on a reversed ruling. Note that the Reset Button only clears out response fields; fouls, timeouts, 
and contests are not cleared.

If you would rather use the keyboard to input information, a command field (located below the Reset button) 
is provided and active, ready to receive keyboard commands. Keyboard commands are r1c (red 1 correct), r1e 
(red 1 error), r1ic (red 1 interrupted correct), r1ie (red 1 interrupted error), r1f (red 1 foul) and so forth for 
the other quizzers. Also, res (reset), rto (red time out), yto (yellow time out), rf (red team foul), yf (yellow 
team foul), rcd (red contest denied), rcw (red contest withdrawn), rcg (red contest granted), ycd, ycw, ycg, 
d (direct question), 2 (two part question), 3 (three part question), 4 (four part question), m (multiple 
part question), qt (quotation question), qc (quotation completion question), cr (cross reference question), and 
l (locate question). Finally, pressing the < (comma) key will go to the previous question and pressing the 
> (period) key will advance to the next question. These shortcuts make it easy for coaches to use the tool 
without struggling with a laptop touchpad.

Many new features have been added to aid coaches during a quiz. All calculations are automatically done for 
you on the scoresheet. The difference between scores is now displayed above the points remaining, letting 
coaches know at a glance which team is winning and by how many points. When a quizzer is about to quiz 
out, their score is highlighted in green on the scoresheet. When a quizzer is about to error out, their score 
is highlighted in orange on the scoresheet. When a quiz is ICED/LOCKED, the message GAME LOCKED appears 
on the message panel.
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It is possible to quickly jump to a question by clicking on the question line on the scoresheet. To correct 
mistakes in scorekeeping, just go back to the question and change the responses as needed. You can 
unclick choices, click correct choices, use the reset button to clear choices, etc. If you do go back and 
make changes, be sure to click the End Quiz Button again so that your changes are reflected on the 
scoresheet final summary.

When the quiz is officially closed, you must hit the End Quiz button to display high scorers at the bottom of 
the scoresheet. The End Quiz Button does not appear until the last question of the quiz. The scoresheet can 
be printed at any time by clicking the Print  button.

Click Exit to return to the tournament matrix. 

Keep Official Time

Official time can be kept with the software. The official timer is now linked to the scoresheet timer. This design 
is intentional so that a scorekeeper can easily and automatically keep official time while keeping score.

To keep official time, click the Call Time check box in the scoresheet interactive panel.

 

By default, the Call Time button will not be checked at the beginning of a quiz. If Call Time is checked, "Time" 
will be called when time expires. If Call Time is not checked, "Time" will not be called. Make sure that your sound 
is on when Call Time is checked, and test the volume ahead of time.

The timer will automatically start when a quizzer response button is clicked or when a timeout or contest box 
is selected. Try to click appropriately to allow a quizzer exactly 30 seconds to respond. Time will automatically 
stop when a response is indicated or when a question is advanced.
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The trickiest thing to remember when keeping official time is to start the 5 second response timer. To start it, 
you can either click the 5 second button in the Timer section, or you can hit the F5 key. Note that if the F5 key 
is hit, the only way to prevent "Time" from being called is to hit the F1 key to cancel.

At any time, F1 will clear the timer. So to prevent "Time" from being called, you can hit the F1 key to cancel 
the timer.

If you need to change something on the scoresheet while time is being kept, you can easily unlink the 
scoresheet timer and the official timer by hitting the F12 key. When the timers are unlinked, the official time will 
be displayed in a light blue color, visually letting you know that the timers are no longer linked. You can 
then change anything on the scoresheet without fear of interrupting the official time. The only way to 
prevent "Time" from being called when the timers are unlinked is to hit the F1 key to cancel.

Keeping official time can be done separate or unlinked from the scoresheet by using the function keys as follows:

F1 clears the timer

F5 for 5 seconds

F3 for 30 seconds

F6 for 60 seconds

F12 to unlink the timers

The most important thing to remember when keeping official time is to hit F1 to clear the timer when needed. If 
F1 is not pressed, time will be called when time expires.

View Summary Window

During a quiz, a summary window can be displayed by selecting the Summary Window Button  . By 
default, the summary window is automatically displayed at the start of a quiz. If a second monitor is attached, 
the summary window will automatically appear on the second monitor.
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If a second monitor is not attached, the summary window will appear on the right hand side of the 
computer screen.

 

As score is kept with the software, the team scores are automatically updated. The red team score is displayed 
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in red, and the yellow team score is displayed in yellow. The current question number is displayed in gray. 
The official time is diplayed in white (or sometimes light blue). See Keep Official Time for more information 
on using the official timer.

The font size can be adjusted by changing the font size number and selecting the Set Button. Choose a 
larger number to make the font larger, and a smaller number to make the font smaller.

To no longer display the summary window, select the Summary Window Button  again. The window 
will automatically close when the scoresheet is exited.

Viewing Statistics

Statistics are available throughout the tournament. To view statistics, make your selection from the left-
hand navigation tree Statistics folder. Expand the Statistics folder by double clicking on it or clicking the plus 
sign to the left of the Statistics folder for the tournament of interest.

 

Scorekeeper Helpers are available in the navigation tree Statistics folder for easy reference. Note that the 
software automatically creates and fills in the scorekeeper helpers for you. Their purpose in the software is for 
easy comparison with the paper copies at the tournament.

All team and quizzer statistics are available in table format. The data in the tables can be sorted by clicking on 
the column headings. Also, the data can be copied by highlighting the data in the table and selecting <CTRL> C 
for copy, then pasted in an Excel table using <CTRL> V ( or paste from the Excel edit menu).

Team statistics are available by selecting Team Stats. Team statistics available include the following:

#GP - Number of games played by this team 
wins - Number of wins for this team 
loss - Number of losses for this team 
PPG - the average points per game, including bonuses and fouls 
PPG2 - the average points per game, EXCLUDING bonuses and fouls 
PAPG - average number of points scored against the team in a game 
MRG - team's average margin of victory (if positive) or defeat (if negative) 
%C - average percent of correct responses per game 
%IC - average percent of interrupted correct responses per game 
%I - percent interruptions is of total points scored by this team via responses (bonuses/fouls excluded) 
%NI - percent non-interruptions is of total points scored by this team 
%RR - percent re-reads is of total points scored by this team (note that sum of %I, %NI, and %RR is 100%) 
%Pts - percentage of the points they attempted and got correct 
max - team's highest final score 
min - team's lowest final score 
#C - average number of correct responses per game 
#IC - average number of interrupted correct responses per game 
10pts - overall average points scored by this team in the 10s 
10rr - average points scored on re-reads in the 10s 
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10ni - average points scored by non-interrupting in the 10s 
10i - average points scored by interrupting in the 10s 
20pts - overall average points scored by this team in the 20s 
20rr - average points scored on re-reads in the 20s 
20ni - average points scored by non-interrupting in the 20s 
20i - average points scored by interrupting in the 20s 
30pts - overall average points scored by this team in the 30s 
30rr - average points scored on re-reads in the 30s 
30ni - average points scored by non-interrupting in the 30s 
30i - average points scored by interrupting in the 30s 

Percentage Point System (PPS) team statistics are available by selecting PPS Team Stats. The Percentage 
Points System (PPS) only calculates statistics based on performance up to the point at which a game is locked. 
This new way to calculate statistics for teams and quizzers is an attempt to more fairly represent their 
performance at a tournament. Credit for the PPS statistics concept goes to Chad Nash, Ryan O'Neil, and 
Calvin Fisher, who have been discussing and calculating these statistics since 2005. PPS team statistics include 
the following:

Note that all of these statistics are calculated only from questions up to the point each game was locked. 
#GP - Number of games played by this team 
wins - Number of wins for this team 
loss - Number of losses for this team 
PPS - the percentage of the total points that the team scored while the game was still competitive 
(includes bonuses and fouls) 
PPS2 - the percentage of the total points that the team scored while the game was still competitive 
(excludes bonuses and fouls) 
PAPS - the percentage of the total points that were scored against this team while the game was still 
competitive (includes bonuses and fouls) 
EA - extrapolated average represents the number of points that a team would score IF they were to 
continue quizzing at the pace that they were when the game was locked 
EA2 - extrapolated average represents the number of points that a team would score IF they were to 
continue quizzing at the pace that they were when the game was locked (excludes bonuses and fouls) 
EAA - 'extrapolated average against' represents the number of points scored against a team IF they were 
to continue quizzing at the pace that they were when the game was locked 
MRG - team's average margin of victory (if positive) or defeat (if negative) 
%C - average percent of correct responses per game 
%IC - average percent of interrupted correct responses per game 
%I - percent interruptions is of total points scored by this team via responses (bonuses/fouls excluded) 
%NI - percent non-interruptions is of total points scored by this team 
%RR - percent re-reads is of total points scored by this team (note that sum of %I, %NI, and %RR is 100%) 
%Pts - percentage of the points they attempted and got correct 
max - team's highest final score 
min - team's lowest final score 
#C - average number of correct responses per game 
#IC - average number of interrupted correct responses per game 
10pts - overall average points scored by this team in the 10s 
10rr - average points scored on re-reads in the 10s 
10ni - average points scored by non-interrupting in the 10s 
10i - average points scored by interrupting in the 10s 
20pts - overall average points scored by this team in the 20s 
20rr - average points scored on re-reads in the 20s 
20ni - average points scored by non-interrupting in the 20s 
20i - average points scored by interrupting in the 20s 
30pts - overall average points scored by this team in the 30s 
30rr - average points scored on re-reads in the 30s 
30ni - average points scored by non-interrupting in the 30s 
30i - average points scored by interrupting in the 30s 
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Quizzer statistics are available by selecting Quizzer Stats. Quizzer statistics available include the following:

PPG - the average points per game for this quizzer in this tournament 
#GP - the number of games played by this quizzer in this tournament 
HS - the number of times this quizzer was high scorer in this tournament 
2HS - the number of times this quizzer was second high scorer in this tournament 
ALL - 'No' means some game data is unavailable, so statistics are not based on all games in which this 
quizzer played 
DPPG - the average points per game for the games from which detailed statistics are calculated 
DGP - the number of games played by this quizzer from which detailed statistics are calculated 
%C - the percentage of all questions answered correctly by this quizzer 
%IC - the percentage of interrupted questions answered correctly by this quizzer 
#QO - the total number of times this quizzer has quizzed out in this tournament 
#C - the average number of correct responses by this quizzer per game 
#IC - the average number of interrupted correct responses by this quizzer per game 
#10C - the average number of correct 10 point questions by this quizzer per game 
#10IC - the average number of interrupted correct 10 point questions by this quizzer per game 
#20C - the average number of correct 20 point questions by this quizzer per game 
#20IC - the average number of interrupted correct 20 point questions by this quizzer per game 
#30C - the average number of correct 30 point questions by this quizzer per game 
#30IC - the average number of interrupted correct 30 point questions by this quizzer per game 

Percentage Point System (PPS) quizzer statistics are available by selecting PPS Quizzer Stats. PPS quizzer 
statistics include the following:

Note that all of these statistics are calculated only from questions up to the point each game was locked. 
ALL - 'No' means some game data is unavailable, so statistics are not based on all games in which this 
quizzer played 
PPS - the percentage of the total points that the quizzer scored while the game was still competitive 
EA - extrapolated average represents the number of points that a quizzer would score IF they were to 
continue quizzing at the pace that they were when the game was locked 
#GP - the number of games played by this quizzer for which PPS statistics are available 
%C - the percentage of all questions answered correctly by this quizzer 
%IC - the percentage of interrupted questions answered correctly by this quizzer 
#QO - the total number of times this quizzer has quizzed out in this tournament 
#C - the average number of correct responses by this quizzer per game 
#IC - the average number of interrupted correct responses by this quizzer per game 
%I - percent interruptions is of total points scored by this quizzer via responses (bonuses/fouls excluded) 
%NI - percent non-interruptions is of total points scored by this quizzer 
%RR - percent re-reads is of total points scored by this quizzer (note that sum of %I, %NI, and %RR is 100%) 
%Pts - percentage of the points they attempted and got correct 
#10C - the average number of correct 10 point questions by this quizzer per game 
#10IC - the average number of interrupted correct 10 point questions by this quizzer per game 
10pts - overall average points scored by this team in the 10s 
10rr - average points scored on re-reads in the 10s 
10ni - average points scored by non-interrupting in the 10s 
10i - average points scored by interrupting in the 10s 
#20C - the average number of correct 20 point questions by this quizzer per game 
#20IC - the average number of interrupted correct 20 point questions by this quizzer per game 
20pts - overall average points scored by this team in the 20s 
20rr - average points scored on re-reads in the 20s 
20ni - average points scored by non-interrupting in the 20s 
20i - average points scored by interrupting in the 20s 
#30C - the average number of correct 30 point questions by this quizzer per game 
#30IC - the average number of interrupted correct 30 point questions by this quizzer per game 
30pts - overall average points scored by this team in the 30s 
30rr - average points scored on re-reads in the 30s 
30ni - average points scored by non-interrupting in the 30s 
30i - average points scored by interrupting in the 30s 
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Sharing Tournament Data between Computers

This software is able to merge tournament data from different computers. With multiple session tournaments 
this feature is especially useful.

To export data for the current tournament, click the Export button (  ) on the toolbar. The Export window 
will appear.

 

Select the location for the exported data. Typically during a tournament you would save the data to an 
external flash drive so that it could be easily transferred to another computer. It is ok to rename the file if 
you wish. Click the Export button after making your file naming and location selections.

Note that the team data (team and quizzer names only) can also be exported in this manner. The only thing to 
do differently is to save the file with the extension .xls to let the software know to export a team file for 
this tournament.

To import tournament data into your application, select the Import button (  ) on the toolbar. The 
Import window will appear.
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Select the exported data file that you want to import. Typically this would be located on an external flash 
drive. Click the Import button to import the selected file. If the import tournament does not already exist on 
your computer, it will be created. If it does exist, the data will smartly merge with your existing data. If 
both datasets have results for a given game, the set with the most information takes precedence. If they have 
the same amount of information, your local information will take precedence.

Working with Multiple Sessions in a Tournament

This software is able to merge tournament data from different sessions at a tournament. If wireless internet is 
not available or if score is being kept without a coordinator license, flash drives or other media must be used 
to transfer the data from one session to another. See Sharing Tournament Data between Computers for 
more information.

If wireless internet is available and the scorekeeper in each session is using the software with a coordinator 
license, then each session's data can be backed up and retrieved wirelessly. To back up a session's data to 

the remote server, select the Backup Session to Server Button  located on the toolbar. The Provide 
Session window will appear.

 

Make sure that each session provides a unique session value, otherwise the sessions will overwrite each other 
on the remote server. When the OK button is selected, the session's data is automatically backed up on the 
remote server. The backup is instantaneous so could be done after every game.

It is now possible to provide a newly created tournament wirelessly to other sessions without first posting results 
to the website. After setting up a tournament, backup the session using the default session 'A'. The other 
sessions can then retrieve the newly created tournament by from the Edit Menu selecting Get Initial 
Backup Session. The Download Backup Tournament Window will appear.
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Select the tournament of interest, then click OK. The tournament matrix will download and appear.

To retrieve all backups from the remote server for all of the sessions, from the Edit Menu select Get 
Backup Sessions from Server.

 

The data from all of the sessions that have backed up to the remote server will be retrieved and merged 
together. The retrieval and merge may take a minute or two, so should only be done between games 
periodically during the tournament.

If during the merge there are any differences between team and quizzer names or game scores, you will 
be prompted to select whether to use the current local data or the imported data. Pay close attention to 
which information is most trustworthy before making a selection. When in doubt, select to trust the current 
data until you can meet with the other session's scorekeeper to discuss the differences.

If you ever get to a game in your session that needs to be played but your matrix has not been updated to 
that point, you need to select who won previous games to get to the current game to be played. Later you 
can obtain the detailed information for the missing games from the other session(s).

Create a Tournament Summary Report

A Tournament Summary Report can be generated listing the final results from the tournament. To access 
the Tournament Summary Report, click on the tournament name in the navigation tree in the left-hand panel 
of the application or from the File menu select Tournament Summary.

     or      
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The Tournament Summary Report screen will appear. In the top half of the panel, input the preferences for 
the selected tournament. 

 

After your preferences are entered, click the Update button to see the summary based on your preferences in 
the bottom half of the panel. Your preferences are saved with this tournament so that if results are posted to 
the website, your preferences will be remembered and used. Note that if you do not modify these preferences 
and update before posting results to the website, the default preferences will be used when displaying the 
results on the website.

The Tournament Summary Report can be printed by clicking on the printer icon button (  ). Note that this 
report is useful when announcing tournament winners.

Create Blank Matrix Forms

To create blank tournament matrix forms, click on the matrix icon (  ) on the main application toolbar. 
The Create a Blank Tournament Matrix Form screen will appear.

 

Make your selections. If you select to generate the matrix using legal size paper, be sure to also set your 
printer settings to use legal size paper. Also, using fast print settings is not recommended since draft or 
fast settings may cause certain matrix lines to not print. If you notice that the printed matrix is missing lines, 
adjust your printer settings for a normal or detailed print.

The Save option will save the blank matrix forms in pdf format. You will be prompted to choose where to save 
the pdf file.

Edit Matrix

The Edit Matrix feature is no longer a supported part of the software. However, since this is the first year for use 
of this software some districts may use different matrix forms. Consequently, the matrix used at a 
tournament could possibly be different from that produced by the software. By editting the matrix, it is possible 
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in most cases to get the tournaments to match in such a way that the same teams play each other. Note that 
the teams will sometimes be on one color buzzer in the tournament and on the other color in the software matrix.

To edit the tournament matrix, first create a tournament with the same number of teams as the official 
tournament matrix. Do not try to input team names in the matrix at this point. Select Edit Matrix from the 
Edit menu. The Edit Matrix panel will appear.

This panel allows the user to change the loser of a game in round 1 to a red or yellow position of a game in 
round 2. To determine where to send the teams in each game, pay close attention to the shape of the 
matrix forms and make sure that the same teams will play each other in both forms. Determining how to edit 
the matrix appropriately can be tedious. Again, this feature is only necessary when a different matrix form is 
used at a tournament. We hope that everyone will eventually use the software-generated matrix forms so that 
this will no longer be an issue. Let your coordinator know that free downloadable matrix forms are available 
at www.upcquiz.com. If anyone has any suggestions for improvement of the software-generated matrix forms 
we are open to new ideas.

This feature is not supported, and is especially not recommended for use by coordinators. If a coordinator 
wishes to use the software they should use the software-generated matrix. Coaches wishing to use the 
software can keep score by using the Practice Quiz feature rather than a tournament if their coordinator uses 
a different matrix.

Delete Local Data

Tournament and practice data is stored locally on the user's computer. It is possible to permanently delete 
local data. To delete a tournament, make sure the tournament to delete is selected/active. From the Edit 
Menu, select Delete Tournament.

A confirmation to delete window will appear.

If selection to permanently delete is selected, the tournament will be removed from the local computer.

Similarly, to delete a practice quiz make sure that the practice quiz to delete is selected then choose Delete 
Practice Quiz from the Edit Menu. The current practice quiz will be deleted if the deletion is confirmed.
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To delete teams, select Delete Teams from the Edit Menu. The Delete Teams window will appear.

Select the team xls files to delete. Note that the teams contained in each team file can be expanded and listed. 
If no teams exist in the team file, it will not have a tree expansion. At this time, team deletion is done by file, so 
all of the teams within the file are deleted. Also note that if the tournament from which the team file was 
created still exists, the team file will be recreated even if you delete it here.

Practice Quizzes

The Practice Quiz feature allows teams to play practice games outside of a tournament. No matrix is used. 

Practice quizzes can be played at any time. To play a practice quiz, select the Practice Quiz  button on the 
main toolbar. The Practice Quiz window will appear.
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Select the quiz type (beginner, junior, intermediate, or senior). To change the teams playing, click the edit 
team button for each team and change them the normal way (see Edit Teams). The Quit button will cancel 
and close the window. To begin the practice quiz, select the Begin Practice Quiz 

 button. The normal scoresheet 
panel will appear, and the quiz can be played. When the quiz is over, it is possible to play another practice 
quiz with the same teams. When the Exit button is selected, a window will appear asking whether or not to 
play again with these same teams.

Practice quizzes are automatically saved, and are organized in the Navigation Tree by month. To delete a 
practice quiz, see Delete Local Data.

Quizzer statistics from practices are available by selecting Practice Stats under the Practices folder in the 
Navigation Tree.

The Select Date Range window will appear.
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Select the range of dates over which to calculate quizzer statistics from practice quizzes. This option allows 
coaches to measure quizzer performance in practice over time.

Post Results to the Website

IMPORTANT: When posting to the website, be sure that the tournament is set up using the appropriate 
Quiz Program setting. The Quiz Program determines which server on which to store the tournament information.

Tournaments can be posted to the website from a coordinator's version of the BQTournament software. Note 
that only coordinators are authorized to post tournament results to help ensure that the website contains 
valid results. Also, internet access is required to be able to reach the website. However, the posting may be 
done at any time during or after a tournament when internet access is available.

It is possible to post results both during and after a tournament. If a tournament is not over, the posted results 
will indicate the number of games that have been played so far. If the tournament is over, the results will show 
the trophy teams, the highest quizzers, and the all tournament team. Very detailed statistics are 
provided. Coordinators can select at the time of the posting whether or not to post quizzer PPGs and 
final standings to keep them a surprise until after the tournament is over.

To post results to the website, click the Post Results to Website  button. A pop-up window will appear 
allowing the coordinator to select whether or not to post quizzer PPGs and final standings. While the 
tournament posts, the Post Results to Website button will activate as indication that the upload is taking place. 
A status window will eventually appear stating that the results posted successfully or that the connection failed 
(if internet access failed).

Download Results from the Website

IMPORTANT: The server from which the data is retrieved is based upon your Quiz Program selection. The 
Quiz Program setting can be changed through the File menu.

Tournaments that have been posted to the website can be downloaded for use in the software. 
Posted tournaments include past tournaments as well as current tournaments. If you are a coach and 
your coordinator is using the software and posting results periodically to the website, you can download the 
lastest posted information to your software. This means that you can have the latest available data for 
a tournament that you are currently participating in if wireless internet is available at that location.

To download tournament results from the website, from the File Menu select Download Data.
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The Download Tournament Window will appear, listing the available tournaments for download by date, 
district, and type.

 

Select the tournament to download and select OK. The tournament will download to your software. Note that if 
the tournament already exists in your software, it will smartly merge with your existing data.

Another way to obtain past tournament data for use in the software is by going to the website's tournament 
results page. For each posted tournament, a file is available for download. This file can be downloaded and 
then imported into the software.

Quiz Program Selection

This software is designed to benefit Bible Quizzing, regardless of quiz program. Currently, the known quiz 
programs that can benefit from this software are United Penecostal Church International (UPCI) Bible 
Quizzing, Worldwide Pentecostal Fellowship (WPF) Bible Quizzing, and Assemblies of the Lord Jesus Christ 
(ALJC) Bible Quizzing. We have servers set up to handle UPC Quizzing and WPF Quizzing, but have not yet 
made provisions for an ALJC Quizzing server. The UPC Quizzing website is www.upcquiz.com, and the 
WPF Quizzing website is www.wpfquiz.com.

To change the Quiz Program in the software, from the File Menu select Change Quiz Program.
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The Select Quiz Program window will appear.

 

Select the quiz program of interest, then click Save. The Quiz Program setting affects district/region selections 
and all website connections from the software, including download of tournaments, posting of tournaments, 
and retrieval of session backups.

How To Use Verse Lookup

Verse lookup has been added to the software, by popular request.  Since this is an unintended "freebie" in 
the software, it works but is not fancy.  I am open to suggestions for improvement, but for now WYSIWYG.
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Lookup can be done from the new text field located on the far right side of the toolbar.

Lookup is also done from the notes field while keeping score during a game.  On each new question, pressing 
the 'n' key will take you directly to the notes field. Pressing the '`' (backward single quote, usually located on 
the same keyboard key as ~ just to the left of the 1 key) will take you back to the command field.

To look up a verse, type the 3-letter abbreviation for the book followed by chapter.verse and hit enter. 
Ex:  gal1.16   eph2.22   phi4.4   col1.9

To look up a key word or phrase, type the key word or phrase and hit enter.

To look up all verses that contain two or more given words, separate each of the words with a space. 
Ex: paul apostle would return all verses containing both Paul AND apostle

To look up two verses and/or phrases, type the first then '/' then the second (no spaces between them) and 
hit enter. 
Ex: gal1.6/salute   gal5.3/gal5.17

So paul apostle would return all verses containing both paul AND apostle whereas paul/apostle would return 
all verses containing either paul OR apostle (not necessarily both in the same verse).

To look up an exact phrase, include the phrase in single quotes. Note that punctuation is ignored, so 'Paul 
an apostle' would return the verse containing 'Paul, an apostle'. 
Ex:  'children of God' would return all verses with that exact phrase

You can advance to the previous or next verse by clicking the buttons in the Material Lookup window.

You can move around and change the size/shape of the Material Lookup window.

I obtained the verses from free public domain (www.biblegateway.com), so there is no guarantee that the 
verses are free from error.
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